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Abstract

In this era, has developed improved methods of repair and retrofitting for
structure with matrix or binder, known as Fibre Reinforced Polymer (FRP). Research
on the behavior of reinforced concrete beams retrofitted by GFRP previously have
been done in the laboratory. However, laboratory results can’t provide the complete
information or data because the limited ability of the tools and testing methods. To
get the accurate experimental results of the test, we need more specimens and it will
be need much money. To overcome this problem, we try to modeling based on Finite
Element Method (FEM). The research method that we used is a simulation
laboratory using LUSAS 14.0 based of finite element method. The test results then
compared with the results of laboratory testing. The test results using the program
LUSAS 14.0 shows that the result is similiar with the result of laboratory. If we
comparison with the normal beam that reinforced concrete beams without refrofitted
by GFRP, it would show that the reinforced concrete beams retrofitted by GFRP
will give increase the capacity of the receiving load beam is equal to 36%. LUSAS
modeling results also show the distribution of strain that occurs in the steel
reinforcement and GFRP along the span. Given the more load on the beam, will
increase the strain of steel and GFRP of the end to the middle of the span and the

maximum strain occurs in the loading area.

Keywords: Reinforced Concrete Beams, Reinforcement Structure, Glass Fibre
Reinforced Poly
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BAB |
PENDAHULUAN

1.1. Latar Belakang

Desain struktur merupakan salah satu bagian dari keseluruhan proses
perencanaan bangunan. Beton bertulang merupakan material yang banyak digunakan
untuk membuat struktur bangunan karena material pembentuknya yang mudah
didapat. Kajian tentang perilaku struktur beton bertulang pada umumnya diperoleh
dari hasil pengujian eksperimental di laboratorium. Pengetahuan tentang perilaku
beton sangatlah penting untuk menghindari terjadinya kesalahan struktural pada beton
ataupun dalam perbaikan atau perkuatan struktur yang mengalami kerusakan dan
kesalahan desain. Saat ini, telah berkembang metode perbaikan dan perkuatan
struktur dengan menggunakan bahan komposit berupa serat sebagai penguat dan
polymer (resin) sebagai matrik atau pengikat yang dikenal dengan Fibre Reinforced
Polymer (FRP). Sistem perkuatan FRP pada beton dilakukan dengan cara
menempelkannya pada permukaan beton dengan menggunakan perekat epoxy.
Perbaikan atau perkuatan struktur dengan bahan ini berupa komposit dengan tulangan

external yang direkatkan pada permukaan beton.

Fibre Reinforced Polymer (FRP) merupakan bahan yang ringan, kuat dan
tahan terhadap korosi. FRP cukup mudah untuk ditempelkan pada beton bertulang
dan terbukti ekonomis digunakan sebagai material untuk memperbaiki dan
meningkatkan ketahanan struktur balok, kolom, pasangan bata, joint balok-kolom dan
bagian struktur lainnya terhadap gempa bumi. FRP dapat berbentuk lembaran,

selubung atau lapisan pada permukaan beton bertulang. Alasan lain penggunaan FRP

-1



adalah karena FRP mempunyai kekuatan ultimit yang lebih tinggi dan bobot yang
lebih rendah dibandingkan dengan baja sehingga penanganannya secara signifikan
menjadi lebih mudah. Secara umum, bahan serat yang digunakan pada FRP ada 3

jenis serat yaitu carbon, aramid dan glass.

Penelitian tentang perilaku balok beton bertulang dengan perkuatan lembar
Glass Fibre Reinforced Polymer (GFRP) sebelumnya telah banyak dilakukan di
laboratorium. Salah satu perilaku yang berkaitan dengan prediksi kegagalan balok
beton bertulang dengan perkuatan lentur menurut Simonelli, 2005 ditunjukkan pada
Gambar 1.1. Gambar 1.1a menunjukkan kegagalan yang disebabkan oleh melelehnya
baja tulangan yang diikuti oleh putusnya FRP. Gambar 1.1b menunjukkan kegagalan
disebabkan oleh hancurnya beton akibat desakan, kasus seperti ditunjukkan pada
Gambar 1.1c adalah kegagalan geser yang biasanya dimulai dari ujung lembaran FRP
dan menyebar sampai balok hancur. Gambar 1.1d menunjukkan kasus bond split
yaitu lepasnya beton penutup baja tulangan pada bagian tarik dan akan terus
menyebar sepanjang baja tulangan, pada kasus seperti Gambar 1.1e disebut sebagai
pengelupasan (laminate peeling) yaitu lepasnya perekat antara permukaan beton dan
lembaran FRP yang biasanya disebabkan oleh kohesif beton yang lebih lemah dari

epoxy resin sebagai perekat antara beton dan FRP.

Namun, hasil penelitian laboratorium yang diperoleh tidak sepenuhnya
memberikan informasi atau data yang lebih akurat dikarenakan adanya keterbatasan
kemampuan alat dan metode pengujian yang dilakukan karena untuk mendapatkan

hasil eksperimental yang lebih akurat tersebut diperlukan data pengujian yang cukup



banyak sehingga diperlukan jumlah benda uji yang banyak pula. Hal ini tentunya juga

akan membutuhkan biaya yang relative mahal.

a) - ]
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Gambar 1.1 Mode kegagalan pada beton bertulang yang diperkuat dengan FRP

Untuk mencoba menanggulangi hal tersebut maka digunakanlah pemodelan

berbasis Finite Element Method (FEM). FEM adalah sebuah metode untuk solusi

numerik dari masalah yang biasa dijumpai di lapangan. Bila suatu kontinum dibagi-

bagi menjadi beberapa bagian yang lebih kecil, maka bagian-bagian kecil ini disebut

elemen hingga. Proses pembagian suatu kontinum menjadi elemen-elemen hingga ini

sering dikenal sebagai proses diskretisasi atau pembagian. Secara umum metode

elemen hingga memiliki beberapa kelebihan, diantaranya:

1. Metode elemen hingga dapat digunakan pada berbagai masalah, analisa

tegangan, analisa medan magnet dan masih banyak lagi.



2. Metode elemen hingga tidak membatasi geometri dari benda, banda apapun
dapat dimodelkan.

3. Kondisi batas dan pembebanan yang dilakukan juga tidak dibatasi.

4. Data material yang yang didefinisikan pada elemen juga tidak dibatasi,
sehingga pada elemen tersebut dapat diubah-ubah data materialnya sesuai
kebutuhan.

5. Dapat menggabungkan beberapa tipe elemen, contohnya pada beton.

6. Memberikan data output yang lebih rinci dan akurat.

Oleh sebab itu berdasarkan dengan pertimbangan diatas maka dalam penelitian
tentang perilaku balok beton bertulang yang diperkuat dengan GFRP ini dilakukan
dengan pemodelan berbasis finite element method atau metode elemen hingga yaitu
LUSAS 14.0. Dengan simulasi pengujian ini diharapkan hasil yang diperoleh dari
pengujian laboratorium adalah sama dan dilengkapi dengan data — data parameter

lainnya yang lebih jelas dan akurat.
1.2. Rumusan Masalah

Berdasarkan pada latar belakang, maka rumusan masalah pada penelitian
ini adalah
1. Bagaimanakah perilaku balok beton bertulang yang diperkuat dengan GFRP

hasil pemodelan berbasis FEM.

2. Bagaimana perbandingan hasil pengujian yang diperoleh dengan pemodelan

berbasis FEM dan pengujian yang dilakukan di laboratorium.



1.3. Maksud dan Tujuan Penelitian
1.3.1. Maksud penelitian :
Adapun maksud dari penelitian ini adalah dalam rangka penyelesaian program
studi Strata 1 pada Jurusan Sipil Fakultas Teknik Universitas Hasanuddin.
1.3.2. Tujuan Penelitian
Tujuan yang diharapkan dalam penyusunan Tugas Akhir ini adalah:
1. Menganalisa perilaku balok beton bertulang yang diperkuat GFRP.
2. Menganalisa hasil yang diperoleh dari penelitian yang dilakukan dengan
menggunakan program finite element method jika dibandingkan dengan

penelitian yang dilakukan di laboratorium

1.4. Batasan Masalah

Untuk mempermudah penyelesaian Tugas Akhir ini tanpa mengurangi bobot
penelitian, maka dalam menyusun studi ini perlu diberikan batasan-batasan. Batasan
masalah akan dijelaskan sebagai berikut :

1.  Parameter penelitian adalah perilaku balok yaitu hubungan beban dan
lendutan, distribusi tegangan dan distribusi regangan yang terjadi dari
pembebanan pada beton bertulang yang dilakukan yang diperkuat dengan
GFRP.

2.  Benda uji yang dimodelkan adalah balok beton bertulang dengan ukuran 15
x 20 x 270 cm dan menggunakan mutu beton f’c = 25 MPa.

3. Program simulasi penelitian yang digunakan adalah berbasis finite element

yaitu LUSAS 14.0.



1.5.

Manfaat Penelitian

Hasil penelitian ini diharapkan dapat memberikan informasi dan masukan

seperti berikut :

1.

1.6.

Sebagai sumber pengetahuan dan informasi mengenai perilaku balok beton
bertulang yang diperkuat dengan lembar GFRP sehingga pemanfaatan FRP

sebagai material perkuatan (retrofit) dapat maksimal.

Sebagai salah satu bahan referensi untuk penelitian selanjutnya khususnya

pada penelitian dengan menggunakan simulasi pengujian berbasis FEM.
Sistematika Penulisan

Penulisan ini dilakukan secara sistematik yang dirangkum dalam beberapa

bab sebagai berikut :

BAB | Pendahuluan

Pada bab ini dijelasakan mengenai latar belakang, maksud penulisan,
tujuan penulisan, ruang lingkup dan batasan masalah serta sistematika penulisan
yang digunakan dalam tugas akhir ini sehingga dapat dipahami secara sistematis.
BAB Il Tinjauan Pustaka

Bab ini berisi teori-teori yang berhubungan dengan penelitian yang
diperoleh dari studi literatur.
BAB Il Metodologi Penelitian

Merupakan bahan mengenai rancangan penelitian, penetapan model, variasi

benda uji dan langkah — langkah dalam teknik pemodelan.



BAB IV Hasil dan Pembahasan

Merupakan hasil yang diperoleh dari pengujian serta pembahasan dari hasil
analisis yang diperoleh.
BABV Penutup

Merupakan bab penutup yang berisikan kesimpulan disertai dengan saran.



BAB Il

TINJAUAN PUSTAKA
2.1 Tinjauan Umum

Aplikasi material Fiber Reinforced Polymer atau FRP sebagai fungsi
perbaikan dan perkuatan struktur beton yang sudah ada telah berkembang pesat di
beberapa negara. Di Indonesia sendiri, pengaplikasian material FRP ini juga telah
dilakukan pada pembangunan gedung — gedung bertingkat. Pembebanan yang terjadi
secara terus menerus atau penambahan beban pada bangunan diluar beban rencana
sering menimbulkan bencana keruntuhan bangunan. Untuk mencegah hal tersebut
maka salah satu cara perkuatan adalah dengan metode external reinforcement yaitu

pemberian FRP yang direkatkan pada permukaan komponen beton.

Fungsi perkuatan dengan sistim komposit FRP adalah untuk meningkatkan
kekuatan atau memberikan peningkatan kapasitas lentur, geser, axial dan daktilitas,
atau berbagai kombinasi lainnya. Daya tahan FRP yang tinggi lebih ekonomis
digunakan pada lingkugan korosif dimana baja akan mudah berkarat. Penggunaan
FRP lebih populer mengingat banyaknya keuntungan yang dapat diperoleh seperti
bobot unit yang kecil, mudah diaplikasikan dan ditangani, biaya instalasi dan
pemeliharaan yang rendah. Kerugian yang paling prinsip penggunaan FRP sebagai

sistim perkuatan adalah harga material yang relatif lebih mahal.

FRP dapat digunakan untuk meningkatkan kapasitas lentur dan geser balok
beton bertulang, lentur pelat, desak, geser dan lentur kolom. FRP dalam bentuk

lembaran, plat atau batangan dapat dipasang pada permukaan balok atau plat yang
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mengalami peregangan sebagai perkuatan lentur. Sebagai perkuatan geser balok,
lembaran FRP dapat direkatkan pada sisi balok. Penggunaan pada kolom, lembaran
FRP atau pelapisan dapat ditempatkan pada bagian luar kolom untuk meningkatkan

daktilitas dan kekuatan.
2.1.1 Beton bertulang

Beton bertulang merupakan struktur yang sangat lazim dalam dunia
konstruksi. Material konstruksi beton bertulang mempunyai sifat yang unik
dibandingkan dengan material lain seperti kayu, baja, aluminium atau plastik karena
beton bertulang adalah material konstruksi yang menggunakan dua jenis bahan yang
berbeda secara bersamaan. Beton bertulang adalah gabungan dua jenis bahan yaitu
beton polos, yang memiliki kekuatan tekan yang tinggi akan tetapi mempunyai
kekuatan tarik yang rendah, dan batangan baja yang ditanamkan di dalam beton yang
dapat memberikan kekuatan tarik yang diperlukan. Beton berfungsi untuk menahan
gaya tekan yang diakibatkan oleh beban-beban yang diberikan dan tulangan besi
untuk menahan gaya tarik yang terjadi. Dengan demikian prinsip-prinsip yang
mengatur perencanaan struktur dari beton bertulang dalam beberapa hal berbeda
dengan prinsip-prinsip yang mengatur perencanaan struktur dari bahan yang terdiri
dari satu macam saja. Kurva Tegangan-Regangan menunjukkan suatu kurva tegangan
regangan tipikal yang diperoleh dari hasil penelitian menggunakan spesimen beton
silinder yang dibebani tekan uniaksial hingga beton hancur. Prilaku tegangan
regangan masih bersifat linier pada saat tegangan pada nilai 0,5/°c, dan berubah
menjadi nonlinier jika tegangan lebih besar dari 0,5/°c. Tegangan maksimum (/)

terjadi pada regangan antara 0,0015 dengan 0,002. Regangan pada tegangan puncak
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disebut g, = 2,4 X 10‘4\/ﬁ. Regangan batas/ultimate beton berkisar antara 0,003
hingga 0,008 namun dalam praktek antara 0,003 hingga 0,004. ACI menetapkan batas
aman atau lower bound regangan maksimum serat desak beton sebesar € ¢, = 0.003
(begitupula dengan SNI 03 — 2847 — 2002) sementara BS 8110 menetapkan € o, =

0.0035.. Gambar 2.1 menunjukkan kurva tegangan-regangan pada beton.
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Gambar 2.1 Kurva tegangan-regangan beton

Kurva tegangan regangan baja akibat beban tarik seperti pada gambar 2.2. Nilai
modulus elastisitas baja bernilai Es = 200.000 Mpa. f, adalah nilai tegangan yang
diberikan ke baja yang mengakibatkan melelehnya baja. Jika tegangan baja fs < f,,

maka fs = Es * &5, namun jika tegangan baja tulangan &5 > f,/Es, maka fs = fy,
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Kurva tegangan regangan aktual
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Gambar 2.2 Kurva tegangan regangan baja

Keutamaan dan kekurangan antara beton dengan baja sebagai bahan penyusun

beton bertulang adalah :

1.

Beton memiliki kekuatan tarik yang buruk (hanya 10-15% dari kekuatan
tekannya) sedangkan baja memiliki kekuatan tarik yang bagus.

Beton memiliki kekuatan tekan yang bagus, baja juga memiliki kuat tekan
yang bagus namun karena kelangsingannya sehingga mudah menekuk.

Beton memiliki kekuatan geser yang cukup bagus, baja juga memiliki kekuatan
geser yang bagus.

Beton memiliki keawetan yang bagus, baja akan berkarat jika tidak terlindungi.
Beton memiliki ketahanan akan kebakaran, baja akan kehilangan kekuatannya

secara cepat pada temperatur tinggi.
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Penerapan beton bertulang dapat ditunjukkan dalam struktur balok. Balok
merupakan elemen struktur yang bekerja untuk menahan lentur dan deformasi.
Gambar 2.3 memperlihatkan kekuatan balok yang secara nyata dapat ditingkatkan
dengan menambahkan batangan-batangan baja di daerah tarik. Baja dan beton dapat
bekerja sama atas beberapa alasan yaitu (1) lekatan (bond, atau interaksi antara
batangan baja dengan beton keras disekelilingnya) yang mencegah slip relatif antara
baja dan beton, (2) campuran beton yang memadai memberikan sifat anti resap yang
cukup dari beton untuk mencegah karat baja dan (3) angka kecepatan muai yang

hampir serupa yaitu dari 0,0000055 sampai dengan 0,000075.

Garis netral

Beton ~

=+~ _ _Daerah tekan

Exaly teloar N

Dacrsh ek = Baja Tulangan —
Baja
4J A Tulangan oo

Potongan A-A

Gambar 2.3 Kedudukan batang — batang tulangan dalam balok beton bertulang

Distribusi tegangan akibat beban lentur akan menyebabkan serat bagian atas
balok tertekan dan serat bagian bawah balok tertarik. Pada saat beban ditingkatkan,
balok tersebut menahan regangan dan defleksi tambahan yang menyebabkan retak-

retak lentur sepanjang serat tarik dari balok tersebut.

Kegagalan pada balok beton bertulang pada dasarnya dipengaruhi oleh
melelehnya tulangan baja dan hancurnya beton bertulang. Ada 3 kemungkinan yang

bisa terjadi penyebab kegagalan balok beton bertulang :
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1. Kondisi Balanced Reinforced
Tulangan tarik mulai leleh tepat pada saat beton mencapai regangan batasnya
dan akan hancur kerena tekan.
Kondis regangan :  €.=0.003 dan & = 4?'—
Pada kondisi ini berlaku :  p = ppajances dan & = &y

2. Kondisi Over-Reinforced
Kondisi terjadi apabila tulangan yang digunakan lebih banyak dari yang
diperlukan dalam keadaan balanced. Keruntuhan ditandai dengan hancurnya
penampang beton terlebih dahulu sebelum tulangan baja meleleh.
Pada kondisi ini berlaku :  p > ppajances dan & <&y

3. Kondisi Under-Reinforced
Kondisi ini terjadi apabila tulangan tarik yang dipakai pada balok kurang dari
yang diperlukan untuk kondisi balanced. Keruntuhan ditandai dengan lelehnya

tulangan baja terlebih dahulu dari betonnya.

Pada kondisi ini berlaku : p <75% p balanced dan €s> €y

p - pmax 0.003

A \K1> O AsQO &' |

As [

000 L

Gambar 2.4 Analisis lentur balok persegi bertulang rangkap
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Analisis lentur balok persegi bertulang rangkap seperti pada gambar 2.4
berhubungan dengan penentuan kuat nominal lentur Mn suatu penampang dengan
nilai-nilai b, d, d’, As, As’, f¢’ dan fy, untuk analisis balok beton bertulang rangkap
pada dasarnya tidak jauh berbeda dengan balok persegi bertulang tunggal. Yang
terpenting untuk dianalisis bahwa tegangan tulangan tekan (fs’) yang merupakan

fungsi dari regangan yang berada tepat pada posisi titik berat tulangan tekan.

2.1.2 Perekat (Adhesive)

FRP direkatkan pada permukaan elemen struktur secara kimiawi dengan
perekat. Perekatan secara kimiawi sangat praktis karena tidak menyebabkan
terjadinya konsentrasi tegangan, lebih mudah dilaksanakan dibandingkan dengan
perekat mekanis dan tidak menyebabkan kerusakan pada material dasar atau material
kompositnya. Perekat yang paling cocok digunakan pada material komposit adalah
perekat yang mempunyai bahan dasar epoxy resin. Perekat ini dibuat dari campuran
dua komponen. Komponen utamanya adalah cairan organik yang diisikan kedalam
kelompok epoxy, mengikat susunan satu atom oksigen dan dua atom karbon. Reaksi
ini ditambahkan pada campuran untuk mendapatkan campuran akhir. Permukaan
yang akan dilekatkan harus dipersiapkan untuk mendapatkan lekatan yang efektif.
Permukaan harus bersih dan kering, bebas dari kontaminan seperti: oxida, oli, minyak

dan debu.
2.1.3 Fibre Reinforced Polymer (FPR)

Material komposit dibentuk oleh dua material atau lebih yang mempunyai

sifat alami dan makroskopik yang berbeda. Pada fiber komposit, dua material itu
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adalah fiber mutu tinggi dan resin. Sifat mekanik komposit adalah yang paling
bertanggung jawab pada jenis ini, tergantung dari arah dan jumlah serat. Sedangkan

fungsi resin adalah untuk mentransfer tegangan dari dan ke serat fiber

Tabel 2.1 Karateristik Material Resin Epoxi

SIFAT MATERIAL EPOXI

Waktu pengeringan : 72 Jam (Suhu ruang :60°C)

SIFAT MATERIAL METODE ASTM NILAI TEST
Kekuatan Tarik ASTM D-638 72.4 Mpa
Modulus Tarik 3.18 Gpa
Persen Regangan ASTM D-638 5%

Kekuatan Lentur ASTM D-790 123.4 Mpa
Modulus Lentur ASTM D-790 3.12 Gpa

Sumber : Fyfo.Co LLC

2.1.3.1 Fiber

Secara spesifik, fibre sebagai material yang diaplikasikan sebagai perkuatan
dapat berupa serat kaca, karbon dan kevlar. Masing-masing mempunyai kemiripan
antara yang satu dengan yang lainnya. Pemilihan tipe fibre untuk aplikasi tertentu
sangat tergantung pada beberapa faktor seperti tipe struktur, beban yang

direncanakan, kondisi lingkungan dan lain-lain. Fibre diproduksi berbentuk:

1. Lembaran, pada umumnya mempunyai arah serat sembarang meskipun ada
yang mempunyai arah serat biaxial dan triaxial, diatas lapisan bagian belakang

yang dapat dilepas atau berbentuk anyaman.
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2. Fibre yang sebelumnya dicairkan dengan resin, dimana perawatannya

dilakukan dengan pemanasan atau dengan cara lain.

Fibre produksi pabrik, kemungkinan mempunyai perbandingan kekuatan
searah serat 70 % dan ke arah melintang serat sebesar 30 %. Fiber mempunyai

ketebalan minimum 0,1 mm dengan lebar 500 mm atau lebih.

2.1.3.2 Glass Fiber Reinforced Polymer (GFRP)

Glass Fiber Reinforced Polymer (GFRP) merupakan material bahan konstruksi
yang terus dikembangkan oleh sebagian kalangan. Material ini cukup memiliki
banyak keuntungan yang dapat diberikan yaitu merupakan material yang tahan
korosi, mempunyai kuat tarik yang tinggi, superior dalam daktilitas, lebih ringan
sehingga tidak memerlukan peralatan yang berat untuk dibawa ke lokasi. Beberapa
jenis serat kaca yang tersedia di pasaran adalah :

(a) E-Glass, yang memiliki kandungan alkali yang lebih rendah dan merupakan
jenis yang paling banyak digunakan. Keuntungannya memiliki sifat mekanis
yang tinggi

(b) Z-Glass, digunakan untuk mortar semen dan beton karena memiliki resistensi
yang tinggi terhadap serangan alkali

(c) A-Glass, yang memiliki kandungan alkali tinggi

(d) C-Glass, yang digunakan untuk aplikasi yang memerlukan ketahanan korosi
yang besar untuk asam, seperti aplikasi kimia.

(e) S atau R-Glass, yang diproduksi untuk ekstra kekuatan tinggi dan modulus yang

tinggi.
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Beberapa metode kegagalan yang sering terjadi pada balok yang diperkuat
dengan FRP vyaitu :
a. Rusaknya FRP setelah tulangan tarik meleleh.
b. Hancurnya beton sekunder setelah tulangan tarik meleleh.
c. Inti beton rusak karena tekanan sebelum tulangan tarik meleleh.

d. Lepasnya ikatan antara FRP dan beton (debonding)

Tabel 2.2 Karateristik material GFRP

KEADAAN LEPAS KEADAAN KOMPOSIT
SIFAT NILAI SIFAT NILAI TEST
MATERIAL TEST MATERIAL TEST DESAIN
Tegangan Tarik 3.24 GPa | Tegangan Ultimit | 575 MPa 460 MPa
Modulus Tarik 72.4 GPa Regangan 0.022 0.022
Regangan Maks. 0.045 Modulus Tarik 26.1 GPa 20.9 GPa
Kerapatan 2.55g/cm3 | Teg. Tarik ultimit | 25.8 GPa 20.7 GPa
Tebal Fiber 0.366 mm Tebal komposit 1.3 mm 1.3 mm

Sumber : Fyfo.Co LLC

2.2 Diskripsi Metode Elemen Hingga

Metode elemen hingga adalah metode numerik yang digunakan untuk
menyelesaikan permasalahan teknik dan problem matematis dari suatu gejala phisis.
Tipe masalah teknis dan matematis phisis yang dapat diselesaikan dengan metode
elemen hingga terbagi dalam dua kelompok, yaitu kelompok analisa struktur dan

kelompok masalah — masalah non — struktur.

Tipe — tipe permasalahan struktur meliputi :
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1. Analisa tegangan/stress, meliputi truss dan frame serta masalah — masalah yang
berhubungan dengan tegangan — tegangan yang terkonsentrasi.
2. Buckling.

3. Analisa getaran.

Masalah non struktur yang dapat diselesaikan dengan menggunakan metode ini
meliputi :

1. Perpindahan panas dan massa.

2. Mekanika fluida termasuk aliran fluida lewat media poros.

3. Distribusi dari potensial listrik dan potensial magnet.

Pada tahap analisis struktur, seringkali dipergunakan model matematis yang
biasanya diekspresikan dalam hubungan atau ketergantungan antara satu atau
beberapa besaran dengan satu atau beberapa besaran lainnya. Hubungan ini umumnya
dinyatakan dalam bentuk persamaan difrensial biasa, persamaan difrensial parsial
atau persamaan lainya. Kenyataannya banyak persoalan analisis struktur yang sangat
rumit sehingga solusi dari model struktur tidak dapat diselesaikan dengan cara eksak,
yaitu cara penyelesaian matematis yang solusinya secara eksak harus memenuhi
hukum-hukum pembentukan model struktur (hukum keseimbangan, kompatibilitas,

dan hukum bahan) disetiap titik dalam model struktur tersebut.

Cara mengatasi persoalan analisis struktur yang terlalu rumit diselesaikan
secara eksak adalah dengan menggunakan aproksimasi. Meskipun solusi yang
dihasilkan tidak eksak, tetapi dapat dibuat sangat dekat dengan hasil yang sebenarnya.

Ada bermacam-macam metode yang sering digunakan untuk menyelesaikan

In-11



persamaan difrensial parsial atau partial diffrensial equation (PDE) secara numerik,
yang pada umumnya melakukan deskritisasi untuk menyederhanakan PDE menjadi
persamaan diskrit simultan, antara lain metode finite difference, metode finite volume,
metode boundary element dan metode elemen hingga. Diantara beberapa metode
tersebut, metode elemen hingga menjadi salah satu yang diterima dan dipakai secara
luas dalam berbagai aplikasi engineering, termasuk dalam analisis problem elastisitas

struktur.

Metode elemen hingga memerlukan prosedur diskritisasi (descritization) untuk
dapat mengubah persamaan difrensial menjadi satu set persamaan aljabar (diskrit)
yang terdiri dari matrik kekakuan, vektor gaya (force vector), dan vektor
displacement yang belum diketahui. Prinsip dari diskritisasi pada metode elemen
hingga adalah memodelkan struktur atau memodelkan elemen struktural menjadi
suatu kumpulan elemen-elemen kecil (assemblage). Bentuk geometrik tiap elemen
dibuat sesederhana mungkin sehingga lebih mudah dianalisis daripada strukur
aslinya. Proses diskritisasi dilakukan dengan cara menentukan titik-titik tertentu
untuk menjadi pemodelan struktur sesungguhnya, yang dinamakan titik nodal (nodal
point), dimana pendifinisian elemen dan analisis selanjutnya hanya mengacu pada
titik-titik tersebut, bukan lagi pada struktur sesungguhnya yang masih merupakan
media kontinyu. Informasi dari titik nodal serta pendifinisian elemen dipakai untuk
membentuk fungsi bentuk, yang digunakan menginterpolasikan respon titik-titik
nodal ke semua lokasi domain yang ditinjau. Prosedur penentuan titik-titik nodal dan
mendifinisikan elemen-elemen untuk mendiskritkan domain struktur yang ditinjau

inilah yang disebut dengan meshing.
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Akan tetapi karakteristik dan bentuk geometri struktur yang ditinjau dapat
berubah seiring berubahnya kondisi struktur, seperti akibat penyebaran retak (crack
propagation) dan deformasi yang besar. Untuk mengatasi hal seperti ini biasanya
perlu dilakukan deskritisasi ulang, dalam kasus metode elemen hingga disebut dengan
remeshing disetiap konfigurasi domain struktur yang berubah sehingga mesh tetap

sesuai dengan bentuk geometri yang baru.

2.2.1 Finite Element Analysis

Pada zaman sekarang ini komputer memungkinkan desain untuk menjadi dinilai
jauh lebih cepat dan mudah. Mengevaluasi desain teknik yang rumit dengan model
matematika yang tepat, bagaimanapun, bukanlah proses yang sederhana. Karena kita
tidak dapat menghitung respon dari bentuk yang kompleks untuk setiap beban
eksternal, kita harus membagi bentuk kompleks menjadi bentuk sederhana yang lebih
kecil dan banyak atau yang disebut elemen hingga. Bentuk masing-masing elemen
hingga adalah didefinisikan oleh koordinat nodenya. Elemen yang berdekatan dengan
node umum akan berinteraksi. Analisis elemen hingga (FEA) atau yang dikenal
dengan metode element hingga (FEM) adalah sebuah metode untuk solusi numerik
dari masalah yang biasa dijumpai di lapangan. Suatu masalah dilapangan umumnya
mengharuskan kita untuk menyelesaikan satu atau lebih variebel yang ada. Bila suatu
kontinum dibagi-bagi menjadi beberapa bagian yang lebih kecil, maka bagian-bagian
kecil ini disebut elemen hingga. Proses pembagian suatu kontinum menjadi elemen-
elemen hingga ini sering dikenal sebagai proses diskretisasi atau pembagian. Dengan
menggunakan metode elemen hingga kita dapat mengubah suatu masalah yang
memiliki jumlah derajat kebebasan tidak berhingga menjadi suatu masalah yang
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memiliki jumlah derajat kebebasan tertentu sehingga proses pemecahannya menjadi
lebih sederhana. Tujuan utama analisis dengan menggunakan metode elemen hingga
adalah untuk memperoleh nilai pendekatan tegangan yang terjadi. Sebaliknya,
pendekatan dengan metode element hingga (finite element methode) merupakan suatu
analisis pendekatan yang berdasarkan asumsi peralihan atau asumsi tegangan, bahkan
dapat juga berdasarkan kombinasi dari kedua asumsi tadi dalam setiap elemennya.

Secara umum metode elemen hingga memiliki beberapa kelebihan,diantaranya:

1. Metode elemen hingga dapat digunakan pada berbagai masalah, analisa
tegangan, analisa medan magnet dan masih banyak lagi.

2. Metode elemen hingga tidak membatasi geometri dari benda, banda apapun
dapat dimodelkan.

3. Kondisi batas dan pembebanan yang dilakukan juga tidak dibatasi.

4. Data meterial yang yang didefinisikan pada elemen juga tidak dibatasi, sehingga
pada elemen tersebut dapat diubah-ubah data materialnya sesuai kebutuhan.

5. Dapat menggabungkan beberapa tipe elemen, contohnya pada beton bertulang.

Metode pelaksanaan analisa sebuah struktur dengan metode elemen hingga secara

garis besar dapat dibagi menjadi seperti berikut :

1. Membagi struktur menjadi elemen-elemen hingga (diskretisasi).

2. Menyusun formulasi sifat atau propertis dari masing-masing elemen.

3. Menggabungkan elemen-elemen hingga dan formulasinya menjadi elemen
utuh/elemen dari struktur

4. Memberikan beban sesuai rencana .
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5. Menentukan kondisi batas (tergantung dari tipe tumpuan struktur)
6. Menyelesaikan persamaan yang terbentuk (hasilnya berupa displacement pada

batas-batas antar elemen tadi.

7. Menghitung tegangan dan gaya-gaya dalam dari elemen-elemen (berdasar

formulasi sifat masing-masing elemen).

2.2.2 LUSAS 14.0

LUSAS versi 14 merupakan salah satu program yang berbasis elemen hingga.
Penyajian model adalah dalam bentuk grafis yang terdiri dari berbagai macam
geometri seperti titik, garis, bidang, volume dan pendifinisian atribut yang berupa
material, beban, tumpuan dan mesh. Program LUSAS menyediakan 100 jenis elemen
yang diklasifikasikan dalam kelompok elemen sesuai dengan fungsinya yaitu: Bars,
Beams, 2D Continum elements, 3D Continum elements, Plates, Shell, Membranes,
Joints, Field Elements dan Interface Elements.

Di dalam analisis finite elemen benda dianggap sebagai kumpulan elemen kecil
yang terhubung pada titik nodal. Perpindahan setiap elemen merupakan interpolasi
dari perpindahan titik nodal yang menghubungkan setiap elemen. Tampilan jendela
LUSAS 14.0 secara umum dapat ditunjukkan aeperti pada gambar 2.6

a. Treeview

Treeview digunakan untuk mengatur berbagai aspek model dalam bingkai
grafis. Pada treeview terdapat lima panel utama yaitu layers, grup, attribut, loadcases

dan utilities.
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b. Properties

Informasi umum berkaitan dengan model disajikan dalam dialog properti.
Properti mungkin berhubungan dengan seluruh model atau fitur geometry. Untuk
melihat properti obyek, tekan tombol mouse kanan, kemudian pilih Properties dari
menu konteks.
c. Status Bar

Status bar menampilkan pesan kemajuan dan bantuan teks selama sesi
modeling, model unit, posisi kursor dalam model unit (jika model ditampilkan dalam
ortogonal) dan jumlah item dalam pilihan saat ini. Pilihan View> Status Bar item

menu dapat digunakan untuk menyembunyikan atau menampilkan status bar.

d. Teks Window

Teks Window memuat pesan dan peringatan selama sesi modeling. View> Text
item menu output dapat digunakan untuk menyembunyikan atau menampilkan Teks
Window.
e. Toolbar

Toolbar berisi tombol toolbar atau tombol pintas pemodelan. Semua toolbar
dapat ditampilkan, tersembunyi, atau disesuaikan, dengan menggunakan View>

Toolbars item menu.
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Gambar 2.6 Tampilan Jendela LUSAS

2.2.2.1 Pemodelan

Secara umum pemodelan dengan menggunakan LUSAS 14.0 secara lengkap

melibatkan tiga tahapan yaitu
a. Menciptakan model
b. Menjalankan analisis

c. Melihat hasil

A. Menciptakan Model

Sebuah model LUSAS secara grafis diwakili oleh fitur geometri (titik (points)

garis (line), bidang (surface), dan volume dan attribute (materials, pembebanan,

tumpuan  (support),

mesh dan geometry). Sebuah model dibuat dengan

mendefinisikan geometry dan attribute dan menandai attribute ke geometry
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Geometri dapat didefinisikan dengan memasukkan koordinat, memilih titik di
layar, atau dengan menggunakan utilitas seperti transformasi atau dengan mengimpor
dari sistem CAD. Atribut didefinisikan dari attribute menu. Setelah didefinisikan,
maka atribut tersebut akan tercantum dalam treeview. Treeview digunakan untuk
mengatur berbagai aspek model dalam bingkai grafis, memiliki lima panel yang
masing-masing menunjukkan layers, grup, attribut, loadcases dan utiliies. Untuk
menyelesaikan model mungkin perlu untuk mendefinisikan data kontrol analisis. Ini

digunakan untuk mengontrol kemajuan analisis.

1. Mendefinisikan Geometry

Pendefinisian geometry dapat dilakukan dengan memilih geometry menu pada
menubar. Pada menu geometri tersedia 4 fitur utama yaitu titik, garis, bidang dan
volume. Titik (points) mendefinisikan simpul dari model elemen hingga, garis (line)
mendefinisikan tepi dari model elemen hingga, surface mendefinisikan permukaan
konstruksi internal model, dan volume mendefiniskan komponen solid sederhana
model. Keempat fitur tersebut dapat didefinisikan melalui menu Geometry > Point,
Line, Surface, dan Volume.

2. Mendefinisikan Atrributes.

Setelah mendefinisikan geometry, selanjutnya adalah pendefinisian attribute.
Define attribute adalah untuk mengidentifikasi dan memasukkan data propertis model
struktur. Untuk mendefiniskan attribute dapat dilakukan dengan memilih menu
Attributes > Mesh, Geometry, Material, Support, Loading. Yang termasuk didalam
sistim attribute LUSAS adalah mesh, geometri, material, support dan pembebanan.

a. Mesh
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Meshing adalah proses untuk menentukan model Lusas dalam hal fitur
geometris yang harus dibagi menjadi elemen hingga dalam penyelesaiannya.
Meshing dilakukan berbeda untuk garis, bidang atau volume. Untuk meshing
volume, elemen yang dipilih harus didefinisikan dalam istilah dari jenis generik
elemen, bentuk elemen dan interpolasi.

b. Geometri
Sifat geometrik yang digunakan untuk menggambarkan attribute geometris
seperti ketebalan, luas, momen kedua daerah, konstan torsi dll. Properti dimasukkan
atau diekstrak dari data di perpustakaan bagian. Untuk model 3-dimensi, tidak ada
kebutuhan untuk menetapkan sifat geometrik.
c.  Material
Setiap bagian dari model harus diberi bahan material. Dalam LUSAS 14.0
material properties terbagi atas :
» Linear dan Nonlinear Material Properties
» Specialise Material Properties
d.  Support
Kondisi ini menjelaskan model tumpuan yang digunakan. Ada tiga kondisi
tumpuan yang dapat digunakan yaitu fee, fix dan kekakuan pegas.
e.  Pembebanan (Loading)
Lusas 14 menyediakan berbagai macam jenis beban mulai dari beban titik,

beban merata, tegangan, displacement dll.

3. Menandai Attribut ke Geometry.
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Setelah geometri dan attribute dedifinisikan, maka selanjutnya dilakukan assign
(penetapan) propertis geometri yang terdiri dari meshing, material, pembebanan, dan
tumpuan (support). Adapun teknik penetapan (assign) adalah dengan drag and drop

sehingga secara otomatis attribute akan terdefinisikan pada pemodelan geometri.
B. Menjalankan Analisis

Secara default, LUSAS akan melakukan analisa tegangan statis linear. Namum
untuk mengatur analisis nonlinear diperlukan kontrol analisis yang merupakan
property dari loadcases, dan loadcases ditampilkan dalam treeview loadcase. Dalam

LUSAS 14.0 proses analisis dikenal dengan istilah solve.

Analisis nonlinier digunakan untuk model perubahan signifikan dalam
geometri, bahan atau kondisi batas. Deformasi geometri yang signifikan dapat terjadi
karena beban yang diterapkan. Perubahan materi dapat terjadi karena hasil material.
Perubahan kondisi batas dapat terjadi dari perubahan kontak atau perilaku gesekan.
LUSAS dapat digunakan untuk model numerik berbagai masalah rekayasa. Dalam

LUSAS secara umum menyediakan analisis linear dan analisis nonliner

e Analisis Linear adalah analisis yang paling umum untuk analisis elastis, analisis
statis linear atau analisis stabil lapangan. Analisis elemen hingga liniar
mengasumsikan bahwa semua bahan berperilaku elastis liniar dan dengan
deformasi cukup kecil untuk secara signifikan mempengaruhi model secara

keseluruhan.
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e Analisis Nonlinear diperlukan karena adanya perubahan gross dalam geometri,
deformasi permanen, retak struktural, tekuk, kontak antara bagian-bagian

komponen.

Setelah model telah dibuat maka selanjutnya dilakukan anlisis dengan memilih
menu File > Lusas Datafile. LUSAS menciptakan sebuah file data dari model, untuk
memecahkan matriks kekakuan, dan menghasilkan file hasil. File hasil akan berisi

beberapa atau semua data sebagai berikut:

a. Tegangan (Stress) g. Reactions

b. Regangan (Strains) h. Yield flags

c. Perpindahan (Displacements) i. Potentials

d. Kecepatan (Velocities) j.  Fluxes

e. Percepatan (Accelerations) k. Gradients

f. Residuals I.  Named variables

C. Menampilkan Hasil Analisis

Hasil yang diperoleh dapat ditampilkan dengan memilih menu Utilities >
Graph Wizard atau dengan klik kanan pada mouse. Untuk menampilkan hasil analisis

dapat melibatkan berbagai macam fitur pilihan antara lain :

Deformed yaitu untuk menunjukkan deformasi yang terjadi pada hasil analisis.

Contur, digunakan untuk menunjukkan kontur distribusi dari tegangan.

Vector, digunakan untuk menunjukkan pola retakan pada model struktur.

Diagram digunakan untuk menunjukkan nilai pada hasil analisis seperti

tegangan.
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e Graphing yang digunakan untuk menunjukkan grafik dari hasil analisis.
e Print Result yang menampilkan hasil yang diperoleh untuk keseluruhan model

struktur seperti tegangan baja, perpindahan dll.

2.2.2.2 Analisis Statis Non Linear
Sifat nonlinear mungkin terbangun dari beberapa bentuk termasuk defleksi yang
besar, tegangan yang besar, hukum tegangan-regangan, deformasi yang tergantung

dari kondisi batas, dan deformasi yang tergantung dari besarnya beban.

A. Analisis Material Non Linear
Jenis analisis ini harus dapat digunakan jika hubungan tegangan-regangan
material benar-benar non linear. Sebagai contoh idealisasi hubungan tegangan-

regangan untuk baja batangan seperti gambar 2.7.

Stress
_ Yield e _
Yield | point T / Hardening
Stress //_ /
/ /
L{Jadin?’fr /
/ fﬁ’
/ /
/ / Elastic unloading/reloading
/ /

Strain
Gambar 2.7 Tegangan regangan untuk baja batangan
Gambar 2.7 menunjukkan linear pada batas elastis dimana analisis elastis dapat
memperkirakan konfigurasi deformasi yang akurat bila batas tegangan leleh tidak
dilampaui. Jika leleh terjadi diikuti dengan menurunnya kekakuan baja masih dapat

mengikuti aturan tegangan-regangan. Oleh karena itu peningkatan beban masih dapat
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diijinkan untuk menggambarkan respon semua material. Gambar 2.8 adalah contoh

sederhana penggabungan dua material baja.

Bar 1

—P» Force

Bar 2

Problem Definition

Force

A Bar 1 Yield
stress

>

Displacement

Faorce P

- Bar 2
- field
- stress

=

Displacement

Stress-Strain Relationship for Bar 2

force A Bar 2 yields Ultimate
. T load
.-"'---
Bar 1 yislds
>

Dizgplacement

Combined Fesponse of System

Gambar 2.8 Contoh sederhana penggabungan dua material baja.

Pemodelan material beton (concrete model) pada FEM LUSAS menggunakan

model yang dikembangkan oleh Jefferson, (1989) untuk model dengan multi crack.
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Model ini memperhitungkan retak akibat tarikan dan kegagalan beton akibat desak. Pada
kurva tekan beton, puncak parabola menunjukkan tegangan tekan maksimum f’c yang
terjadi saat regangan tekan beton mencapai ¢’c dan bagian menurun berupa kurva
regangan maksimum ecu, terjadi ketika tegangan maksimum beton f’cu tercapai. Pada
kurva tarik beton puncak parabola menunjukkan besarnya tegangan maksimum tarik
beton 7t dan bagian menurun berupa kurva regangan o, terjadi ketika tegangan tarik
beton maksimum tercapai. Pada Program FEM LUSAS didifinisikan sebagai concrete
(model 94). Model material beton pada FEM LUSAS dapat digunakan untuk

memodelkan 2-D (dua dimensi) atau 3-D (tiga dimensi).

Hubungan tegangan-regangan material beton ditunjukkan pada Gambar 2.9.
Default FEM LUSAS menyediakan formulasi kurva tegangan-regangan material beton,

namun kontrol kurva masih tetap diperlukan sebagai input data.

E¢

fe
f:u i Ecu

Eo

oo

Gambar 2.9. Perilaku hubungan tegangan — regangan material beton
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B. Software Analisis Finite Elemen LUSAS

Analisis finite elemen secara lengkap terdiri dari 3 (tiga) langkah, yaitu: pre-
processing, finite element solver dan result processing. Sistem pada program finite
elemen LUSAS, mengandung dua bagian pelaksanaan analisis finite elemen secara

lengkap yaitu:

1. LUSAS Modeller, sangat interaktif bagi pengguna dalam pemodelan grafis
sebelum dan sesudah proses.

2. LUSAS Solver, untuk melaksanakan Analisis Finite Elemen.

Memaodel struktur dilaksanakan pada tahap pra-proses. Model disajikan dalam
bentuk grafis dengan dua bagian besar yaitu fitur geometri dan assign attribute.
Terdapat empat fitur geometri pada LUSAS vyaitu titik, garis, bidang dan volume.
Dasar penggambaran geometri adalah beberapa titik yang dihubungkan menjadi garis;
garis dengan garis yang berhubungan menjadi bidang dan kombinasi beberapa bidang
menjadi volume. Seluruh geometri harus dipastikan menurut sistim sumbu cartesian

demikian juga untuk sistim sumbu lokal dan sistim sumbu global.

Berikutnya adalah tahap solusi yang dikenal sebagai finite element solver.
Metode kekakuan akan diproses pada tahap ini dan menghasilkan file data yang
diperlukan. Tahap akhir adalah proses hasil dengan melibatkan penggunaan perangkat
untuk melihat dan menganalisis jawaban yang dihasilkan oleh LUSAS Solver.
LUSAS memiliki beberapa model material yang berbeda dengan variasi cara

pemodelan pisik material yang diijinkan termasuk baja elastis, beton, busa dan tanah.
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1. Element 1-dimensi

Elemen 1-dimensi hanya digunakan jika perpindahan atau tempratur
mempunyai fungsi untuk satu kordinat saja. Jenis elemen ini harus mempunyai
sekurang-kurangnya dua titik dalam sumbu kontroidalnya. Elemen ini dapat
mempunyai 2 titik, 3 titik, 4 titik dan seterusnya, semakin banyak titik akan
memberikan hasil dengan akurasi yang lebih tinggi, tetapi pada saat yang sama
membutuhkan kalkulasi yang lebih komplek. Contoh elemen 1-dimensi adalah
elemen linear quadratic dan elemen kubik. Gambar 2.10 menunjukkan elemen 1
dimensi dan gambar 2.11 menunjukkan penambahan beban yang bekerja pada model

kantilever yang menggunakan elemen 1-dimensi.

centroid axis
S DO et oo oot oo O
# | L 4 # J (8] [§] L 3
less accurate mare aceurate

Gambar 2.10 Elemen 1 — dimensi

load

¢ a ) OEENONNON _

Gambar 2.11 Penambahan beban yang bekerja pada model kantilever yng

menggunakan elemen 1 — dimensi

Il-26



2. Elemen 2-dimensi

Elemen 2-dimensi digunakan jika perpindahan atau tempratur mempunyai
fungsi untuk dua kordinat x dan y. Jenis elemen ini merupakan layer yang
mempunyai tiga titik penghubung atau lebih. Contoh untuk elemen 2-dimensi adalah
elemen linear triangular, yang paling mudah untuk dimodel, elemen linear

rectangular, elemen kurva triangular dan elemen kurva rectangular.

Gambar 2.12 Elemen 2 dimensi

3. Elemen 3-dimensi

Elemen 3-dimensi digunakan jika perpindahan atau tempratur mempunyai
fungsi untuk tiga kordinat x, y dan z. Masing-masing panjang tepi sangat menentukan
sebab tidak terdapat dimensi elemen yang lebih besar dari 2-dimensi lainnya. Elemen
3-dimensi paling banyak diterapkan sampai saat ini sehubungan dengan tingkat

akurasinya. Gambar 2.13 menunjukkan beberapa variasi elemen 3-dimensi.
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. [t ]

Gambar 2.13 Beberapa variasi elemen 3 dimensi

2.2.2.3 Kesatuan Elemen 2 Dimensi

A. Plane stress (QPM4, QPMS8, TPM3, TPM6, QPKS8, TPKG6)
Unsur-unsur plane stress cocok untuk menganalisis struktur balok beton dan

pelat tipis seperti pada gambar 2.14.

REEEE _
Lbiidd T

() Plare subject 1o Inplane Loading

Fﬂ
i

Problem Defniton Finite Element Mosh

() Capilever subject to 2 Poinr Loadmg

Gambar 2. 14. Contoh ilustrasi menggunakan tipe struktur Plane Stress
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B. Evaluasi Tegangan ( Evaluation of stresses)
Output elemen diperoleh pada node elemen dan Gauss poin yang terdiri dari
e  Stress Output
Ox Oy Oyxy, 0, adalah tegangan langsung dan geser

Omaxs Omin adalah tegangan maksimum dan minimum

B adalah sudut antara tegangan utama maksimum dan sumbu X
positif

os adalah tegangan geser maksimum

ov adalah tegangan von Mises ekivalen.

e Strain Output

€x €y Yxv, € adalah strain langsung dan geser

€ max, € min adalah strain maksimum dan minimum

B adalah sudut antara strain maksimum dan sumbu X positif.
€s adalah strain geser maksimum.
Ev adalah strain von Mises ekivalen.

Tegangan yang dihasilkan memperhitungakan ketebalan elemen, tersedia

sebagai alternatif tegangan output untuk elemen plane stress.

e Stress Resultant Output
Nx, Ny, Nxy, N; adalah tegangan regangan langsung dan resultan/
satuan panjang.
Nmax, Nmin adalah  resultant tegangan minimum  dan

maksimum/ satuan panjang
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B adalah sudut antara resultant tegangan maksimum

dan sumbu X positif.

Ns adalah tegangan geser resultan / unit panjang
maksimum
Ny adalah von Mises setara resultan / satuan panjang

Tanda konvensi untuk tegangan, resultan tegangan dan output regangan dapat

ditunjukkan pada gambar 2.15.

Elemen isoparametric elements dapat digunakan dalam :
a. Analisis material nonlinear dan model beton. Untuk model beton dapat
digunakan elemen plane stress.
b. Analisis geometris nonlinier.
c. Analisis geometri dan material nonlinear menggunakan hukum nonlinear
material.
d. Dinamika nonlinear memanfaatkan hukum material nonlinier

e. Linear eigen-tekuk analisis.

o, O, tre tension
Ty Ve into XY quadrant

Gambar 2.15 Tegangan bidang pada sumbu x dan y.
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2.2.2.4  Model Material Plastic — Isotropic.

Berikut ini adalah model Isotropic yang tersedia dari Atribut>
Material>lIsotropic menu dengan mencentang Plastic pada atribut materi kotak

dialog.

e Stress Potensial (von Mises) sifat material nonlinier berlaku untuk multi-
aksial tegangan yang membutuhkan spesifikasi tegangan hasil dalam setiap
arah dari ruang tegangan. Menggabungkan hardening, yield stress dan heat
friction.

e Optimised von Mises (Model 75) merupakan perilaku daktail bahan yang
menunjukkan volumetric strain (misalnya, logam)

e Tresca (Model 61) merupakan perilaku daktail bahan yang memperlihatkan
regangan volumetrik (misalnya, logam). Menggabungkan isotropic
hardening.

e Mohr-Coulomb (Model 65) tidak terkait dengan Mohr Coulomb Model
merupakan bahan friksional yang memperlihatkan peningkatan kekuatan
geser dengan meningkatnya tegangan yang membatasi (misalnya, bahan
granular seperti batu dan tanah). Model ini menggabungkan isotropik
hardening dan dilatancy.

e Drucker-Prager (Model 64) merupakan perilaku daktailt bahan yang
menunjukkan regangan plastik volumetrik (misalnya bahan granular seperti

beton, batu dan tanah). Menggabungkan isotropic hardening.
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e Concrete (Model 94) untuk pemodelan 2 dan 3 dimensi dengan
memperhitungkan perilaku nonlinear dan mampu memodelkan retak yang
terjadi.

e Stress Resultan (Model 29) dapat digunakan untuk balok. Model
diformulasikan langsung dengan balok atau shell stres resultants ditambah

sifat geometric.

Dalam penelitian ini pemodelan yang akan digunakan adalah Von Mises
Criteria. Von Mises Criteria adalah kriteria hasil yang paling diterima secara
universal untuk logam. Kriteria ini didasarkan pada pertimbangan energi regangan .
Model Von Misses didefinisikan sebagai stress potential model dengan input data

terdiri dari :

e Material properties : E (Young’s modulus), v (Poisson ratio), fy (Yield Stress)
dan heat friction.

e Hardening properties, yang secara default FEA LUSAS menyediakan tiga
metode untuk mendefiniskan nonlinear hardening yaitu : hardening gradient,
plastic gradient dan total strain.

Ada tiga metode untuk menentukan nonlinier hardening. Kurva hardening
dapat didefinisikan dari segi baik gradien pengerasan, strain plastik atau regangan

total seperti pada gambar 2.16.
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Gambar 2. 16 Kurva Hardeing (Hardening Curve)

(Sumber : FEA LUSAS)

2.2.2.5 Joint element Meshes

Joint elemen digunakan untuk menghubungkan dua atau lebih node/simpul

oleh spring. Interface element digunakan untuk memodelkan interface delaminasi
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dalam bahan komposit. Untuk joint dan interface elements dimasukkan diantara node
yang sesuai dan fitur dengan menggunakan interface meshes. Joint element
didefiniskan sebagai Line atau Surface. Dalam analisis 2D, line joint mesh ditetapkan
untuk fitur Line dan dalam analisis 3D Surface joint mesh ditetapkan ke fitur Surface.
Untuk menetapkan data joint mesh dapat digunakan dua cara yaitu :

a. Single Joint ( Lines only). Dalam metode ini joint meshes ditetapkan langsung
ke Single Line. Metode ini lebih cocok untuk mendefiniskan satu atau dua
joint dimana fitur line harus didefinisikan untuk setiap joint yang diperlukan.

b. Joint Mesh Interface (Lines and Surface) menggunakan master dan slave
untuk mengikat dua line atau dua surface secara bersamaan dengan joint
mesh. Ketika menggunakan interface meshing joint properties harus
didefinisikan per satuan panjang jika ditetapkan sebagai line dan persatuan

luas jika ditetapkan sebagai surface.

Untuk memodelkan single joint element tunggal antara dua titik dapat

dilakukan dengan

1. Membuat line yang menghubungkan 2 titik
2. Menentukan dataset joint element dengan memilih joint element.

3. Menetapkan line mesh ke line antara 2 titik.

Untuk memodelkan joint mesh interface dapat dilakukan sebagai berikut.

1. Menambahkan fitur slave pada memory seleksi
2. Memilih fitur master

3. Menetapkan joint mesh.
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Material joint dapat menghubungkan joint elemen untuk mendefinisikan sifat
material untuk joint model linear dan nonlinear. Terdapat enam model joint yang
disediakan dalam LUSAS 14.0 yaitu:

1. Model Joint Linear yang terdiri dari :
a. Spring Stiffnes Only, yang dapat digunakan untuk setiap local freedom.
b. General properties adalah sifat gabungan penuh dari spring stiffness, mass,
coefficient of linear expansion and damping factor
2. Model Joint Nonlinear, yang terdiri dari :
a. Elasto — Plasto Uniform tension and compression dengan isotropic hardening.
b. Elasto — Plastic General dengan isotropic hardening, dimana tegangan leleh
diasumsikan.
c. Smooth Contact dengan sebuah initial gap

d. Frictional Contact dengan sebuah initial gap.

[B]

Gambar 2.17 Springs yang menghubungkan dua node dalam 2-D (Tanpa Kekakuan

rotasi)
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